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APÈNDIX 

Símbol Descripció 

a, b, c, d, R, S, Y Variables per definir procés de fissuració. 

Acr Secció transversal esquerdada del tirant. 

Ae Secció transversal efectiva del tirant. 

Af Secció del formigó. 

Ag Secció bruta del tirant. 

Ar Secció de la barra de reforç. 

b Cantell del formigó. 

db Diàmetre de la barra de reforç. 

Eacer Mòdul de Young de l’acer. 

Ecm Mòdul secant d’elasticitat. 

Ef Mòdul de Young del formigó. 

EFRP Mòdul de Young de les barres de FRP. 

fck Resistència del formigó. 

fcm Resistència característica a compressió. 

fctm Resistència mitjana a tracció axial. 

lt Longitud de transferència. 

n Rati de mòduls elàstics, n=Er/Ec. 

P Càrrega aplicada. 

Pcrack Càrrega en el moment en què apareix la primera fissura. 

s Lliscament de la barra respecte el formigó. 

s1, s2, s3 Valors de lliscament . 

Ur Desplaçament absolut de l’armadura. 

Uf Desplaçament absolut del formigó. 

α Coeficient. 
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β Paràmetre pels models adherència-lliscament. 

β1 Coeficient referent a l’adherència del reforç en EC-2. 

β2 Coeficient que considera el tipus de càrrega en EC-2. 

βd Coeficient de reducció proposat per ACI per adaptar el model 

d’acer a FRP. 

ε1 Deformació d’una secció no fissurada. 

ε2 Deformació d’una secció fissurada. 

εf Deformació unitària del formigó. 

εm Deformació mitjana. 

εr Deformació unitària del reforç. 

εsr1, εsr2 Deformació en el reforç d’acer en una secció fissurada i una no 

fissurada, respectivament. 

ρ Quantia geomètrica, ρ=(Ar/Af). 

σcr Tensió en el reforç d’acer durant l’aparició de la primera fissura. 

σsr1, σsr2 Tensió en el reforç d’acer en una secció fissurada i una no 

fissurada, respectivament. 

σsrn Tensió en el reforç d’acer a la última fissura. 

τ Tensió d’adherència. 

τf Tensió d’adherència residual. 

τmax Tensió màxima d’adherència. 
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1 INTRODUCCIÓ 

Des de finals del segle XIX, el formigó armat ha estat la tècnica constructiva de referència en les 

construccions del nostre país.   

El formigó s’obté de la mescla de ciment (o algun altre conglomerat), grava i aigua, obtenint així una 

pasta modelable, capaç d’adaptar-se a qualsevol forma del motlle o encofrat, i que endureix amb 

facilitat. Caracteritzat per la seva fragilitat, només és capaç d’aguantar esforços de compressió, 

mostrant-se ineficaç suportant esforços elevats de tracció i flexió. Aquestes característiques fan que 

sigui necessari utilitzar barres de reforç. 

Les bones propietats mecàniques de l’acer i la similitud en propietats d’expansió tèrmica entre 

formigó i acer fan que la combinació d’aquests dos materials sigui eficient i permeti garantir un bon 

comportament mecànic, en el que el formigó resisteix els esforços de compressió i el reforç d’acer 

resisteixi els de tracció. Aquesta combinació fa que el formigó armat amb acer sigui idoni pel seu ús 

en la construcció actual i passada. 

Però existeixen problemes de durabilitat per efecte de la corrosió que pateixen les armadures 

convencionals d’acer, sobretot en ambients humits i alcalins. És per això que l’ús de barres de 

materials compòsits de matriu polimèrica (FRP, de l’anglès Fiber Reinforced Polymers) com a reforç 

en estructures de formigó es contempla com una solució efectiva per fer front a aquesta 

problemàtica. 

Les barres de FRP estan formades per fibres d’alta resistència que es troben envoltades per una 

matriu de resina, que les protegeix de la corrosió. Aquest és un clar avantatge en l’ús d’aquestes 

barres enfront l’ús de barres d’acer. Cal tenir en compte, però, que tant les propietats mecàniques 

com l’acabat superficial d’aquestes barres canvien respecte les de l’acer, i això pot afectar en 

l’adherència entre els dos materials i per tant el comportament final d’un element de formigó armat.   

1.1 Antecedents 

Les característiques mecàniques i adherents dels FRP utilitzats com a reforç intern d’elements de 

formigó armat donen com a resultat uns nivells de fissuració més elevats que els obtinguts amb 

formigó armat amb acer convencional. Això afecta directament el seu comportament en servei i farà 

que aquest regeixi el disseny d’aquest tipus d’elements. 

En aquest sentit, és essencial conèixer i entendre el procés de fissuració del formigó armat degut a 

esforços de tracció, procés que depèn de l’adherència formigó-reforç i de l’efecte tenso-rigidesa 

(més conegut pel seu terme anglès tension stiffening) que d’aquesta interacció se’n deriva. 
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1.2 Objecte 

L’objectiu d’aquest projecte és l’anàlisi del fenomen del tension stiffening analitzant el procés de 

fissuració d’un tirant de formigó armat sotmès a tracció pura, mitjançant eines numèriques. 

1.3 Abast 

Els models numèrics que es faran servir consideraran el comportament inelàstic del formigó i un 

comportament elàstic lineal de la barra de reforç. Amb aquests models, es realitzaran estudis per 

analitzar la possible influència de paràmetres com quantia geomètrica (ρ), diàmetre de la barra (db), 

cantell de la secció rectangular de formigó (b) o rati del mòdul elàstic del material de reforç respecte 

mòdul elàstic del formigó (n=Er/Ec).  
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2 CONCEPTES PREVIS 

2.1 Adherència entre formigó i barres de reforç d’acer 

L’adherència és el fenomen bàsic pel qual es fonamenta el funcionament del formigó armat com a 

material estructural. Si no existís l’adherència, no hi hauria transmissió d’esforços entre formigó i 

material de reforç, i per tant les barres de reforç lliscarien pel formigó sense cap mena d’oposició. Es 

pot dir doncs que és l’adherència qui garanteix el treball conjunt dels dos materials. 

Existeixen tres mecanismes principals d’adherència, que venen originats per dos tipus de causes: 

• El mecanisme d’encunyament del formigó, de naturalesa mecànica, és el mecanisme 

principal en el desenvolupament de l’adherència, i es caracteritza com la resistència al 

lliscament degut a la penetració del ciment a les irregularitats de les barres. 

• El mecanisme d’adhesió química, de naturalesa física, provoca l’adhesió de les barres i el 

formigó a través de forces capil·lars i molècules desenvolupades a la interfase.  

• El mecanisme de fregament, també de naturalesa mecànica, té lloc a la interfície barra-

formigó. 

2.1.1 Factors influents en l’adherència 

Hi ha molts factors que influeixen en l’adherència entre formigó i barra de reforç d’acer. Cal entendre 

aquests factors per poder establir analogies, si fos el cas, quan el reforç consisteixi en barres de 

FRP. 

La resistència del formigó és un dels factors més importants quan es vol garantir una bona 

adherència. Cal tenir en compte que l’inici de pèrdua d’adherència tindrà lloc quan les tensions en el 

formigó superin la seva resistència a tracció i apareguin les primeres fissures. Aquesta clara 

dependència entre resistència del formigó i adherència està clarament reconeguda en diferents codis 

pràctics [1,2].  

L’extens estat de l’art confirma que barres de reforç de diàmetres majors desenvolupen tensions 

d’adherència més petites que les que es generen en barres de reforç de diàmetres menors. 

Novament, aquest efecte es veu reflectit a codis com ACI 318R-05 [1], que introdueix un factor de 

mida de reforç en la fórmula proposada per determinar la longitud efectiva. 

La pressió transversal té un doble efecte sobre l’adherència: i) retarda l’aparició de les primeres 

fissures i, ii) fa augmentar la força de fricció entre els dos elements (formigó i reforç). Com a resultat 

de l’existència d’una pressió transversal, s’obté un increment en la tensió d’adherència i una 

reducció en els valors de lliscament. 
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2.1.2 Relació entre la tensió d’adherència i el lliscament 

Existeixen diferents assajos per caracteritzar l’adherència. Els dos més utilitzats en la literatura de 

referència són l’assaig de pull-out i l’assaig beam-test (Figura 2.1). La simplicitat i facilitat d’execució 

de l’assaig de pull-out ha fet que aquest sigui l’assaig més utilitzat, tot i que l’estat tensional que els 

elements tenen en aquest assaig difereix de l’estat tensional que té lloc a la zona de tracció 

d’elements a flexió. És per això que es diu que l’assaig de pull-out és un assaig qualitativament 

correcte. 

 

Figura 2.1 Assajos d’adherència pull-out i beam-test 

En qualsevol d’aquests assajos d’adherència, els resultats que s’obtenen es representen mitjançant 

una relació entre la tensió d’adherència, τ1, i el lliscament de la barra respecte el formigó, s1. La 

tensió d’adherència es defineix com la tensió tallant que es genera a la interfície formigó-barra com a 

resultat de la força de tracció aplicada, mentre que el lliscament es defineix com el desplaçament 

relatiu entre formigó i barra. 
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Novament, la rugositat de les barres, la resistència del formigó, la posició i orientació de les barres, 

així com les condicions de contorn són alguns dels factors que afecten a la corba final de tensió 

d’adherència-lliscament. 

Per entendre com es generen les tensions d’adherència cal tenir en compte les següents 

consideracions: 

- Armadura i formigó tenen la mateixa deformació a les zones de l’estructura sotmeses a 

compressió i també en les parts no fissurades de les zones a tracció.  

- A les seccions transversals amb fissures, els esforços de tracció es transmeten a través de 

l’armadura. Els desplaçaments absoluts de l’armadura, Ur,  i formigó, Uf, entre dues fissures 

són diferents. Aquesta diferència, anomenada desplaçament relatiu o lliscament, s, provoca 

tensions d’adherència entre els dos elements del formigó armat. La magnitud d’aquestes 

depèn fonamentalment de la superfície de l’armadura, el lliscament i la resistència del 

formigó. 

A la Figura 2.2 es mostra la corba d’adherència entre formigó  i reforç d’acer proposada a MC2010 

[3]. Aquesta corba té quatre etapes, que es distingeixen pel lliscament, s. 

 

Figura 2.2 Gràfic adherència-lliscament MC2010 

Per càrregues monòtones, les tensions d’adherència entre el formigó i les barres de reforç es poden 

calcular en funció del desplaçament relatiu s, d’acord amb les Equacions 1 a 4: 

� = ���� � �
��	


     ��
 0 ≤ � ≤ �� 

Equació 1 
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� = ����      ��
 �� ≤ � ≤ �� 

Equació 2 

    

� = ���� − (���� − ��) � ����
�����	   ��
 �� ≤ � ≤ �� 

Equació 3 

    

� = ��       ��
 �� ≤ � ≤ �� 

Equació 4 

on τ és la tensió d’adherència per un lliscat s, τmax és la tensió màxima d’adherència, τf és la tensió 

d’adherència residual, s és el lliscament, s1, s2 i s3 són valors de lliscament que delimiten les quatre 

zones i α és un coeficient. 

2.2 FRP com a reforç d’estructures 

Les barres de FRP es presenten com a un reforç alternatiu per la construcció, especialment en 

ambients corrosius. Aquestes barres estan constituïdes per  fibres contínues (ja sigui de vidre, 

carboni o aramida)  impregnades d’una matriu de resina (normalment epoxi, polièster o vinilèster).  

A continuació es mostren quins són els avantatges i inconvenients del seu ús, enfront el reforç 

d’acer:  

Avantatges dels FRP:   

• Elevat rati de resistència/pes propi (de 10 a 15 vegades major al de l’acer). 

• Bon comportament a fatiga, pel cas de barres amb fibres de carboni i aramida. 

• Neutralitat electromagnètica. 

• Baix coeficient de dilatació tèrmica. 

Inconvenients dels FRP: 

• Elevat cost de matèria primera. 

• Gran variabilitat de mòduls elàstics, en funció del material de la fibra, normalment amb valors 

inferiors als de l’acer (excepte pel cas d’alguns FRP de carboni). 

• Comportament fràgil. 

Les tècniques de fabricació poden ser des de la laminació per corró fins a bobinatge per filaments i 

trenat, però la més corrent és la pultrusió. L’elecció de la tècnica depèn del tipus de fibra i de matriu, 

la temperatura necessària per formar la peça i curar la matriu, i el cost efectiu del procés. 
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2.2.1 Propietats mecàniques dels FRP 

Al ser un material compòsit, les propietats dels FRP varien significativament depenent de la 

naturalesa i el volum de les fibres, les propietats de la resina i l’orientació de les fibres. És per això 

que no és possible establir uns valors universals sinó que només és possible obtenir valors 

orientatius. En la Taula 2.1 es mostra una comparació de les propietats de diferents FRP (vidre, 

GFRP; carboni CFRP; aramida, AFRP) i de l’acer. 

 

Propietat GFRP CFRP AFRP Acer 

Densitat (kg/cm3) 1.25÷2.1 1.5÷1.6 1.25÷1.4 7.9 

Coeficient longitudinal 
d’expansió tèrmica (10-6/ºC) 6÷10 -9÷0 -6÷-2 11.7 

Coeficient transversal 
d’expansió tèrmica (10-6/ºC) 21-23 71-104 60-80 11.7 

Tensió deformació elàstica 
(MPa) - - - 400÷500 

Resitència tracció 
longitudinal (MPa) 480÷1600 600÷3690 1720÷2540 550 

Modul longitudinal (GPa) 35÷50 120÷580 41÷125 200 

Tensió deformació per 
tracció longitudinal (%) - - - 0.20÷0.25 

Deformació per tracció 
longitudinal final (%) 1.2÷3.1 0.5÷1.7 1.9÷4.4 15÷20 

Taula 2.1 Comparació propietats mecàniques FRP-acer 

 

2.2.2 Interacció FRP-formigó 

L’existència de diferències en el comportament mecànic de les barres de FRP enfront les d’acer fa 

que la interacció entre barres de reforç de FRP i formigó sigui diferent a la interacció entre acer i 

formigó. Segons [4], aquesta interacció dependrà de si la barra considerada té un acabat superficial 

llis o amb corrugues/deformacions. 

Si es considera una barra de reforç llisa, l’adherència és governada principalment bé per l’adhesió 

entre la superfície de la barra i el formigó circumdant o bé per la resistència laminar a tallant de les 

successives capes de fibres a la superfície de la barra. A causa de l’acabat llis de les barres és poc 

provable que hi hagi formació de fissures i les tensions d’adherència augmentin. 

Si en canvi es considera una barra amb corrugues/deformacions, els mecanismes d’adherència que 

s’activen són uns altres, i la corba d’adherència es descriuria segons s’indica a la Figura 2.3 [4]. 
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Figura 2.3 Corba tensió d'adherència mitjana - lliscament de l’extrem d'una barra curta de FRP. 

Quan hi apliquem una càrrega (punt A) el mecanisme d’unió entre els dos materials és de naturalesa 

química. Per aquests nivells de tensió no apareix lliscament entre els dos materials. Per valors de 

tensió d’adherència superiors a τa (fins al punt B) el lliscament a l’extrem carregat de la barra 

augmenta i les corrugues/deformacions de la barra provoquen grans pressions de contacte en el 

formigó, fent aparèixer petites fissures a les puntes de les corrugues/deformacions de la barra que 

permetran el lliscament de la barra. A mida que el lliscament augmenta (tram BC) aquestes 

pressions augmenten considerablement i la component radial es veu compensada per els esforços a 

tracció del formigó. Si la barra no està ben confinada és possible que la tensió de tracció superi la 

màxima del formigó i apareguin esquerdes al llarg de la longitud de la barra de reforç. Si, en cas 

contrari, hi ha una resistència suficient al lliscament, s’assoleix la tensió màxima d’adherència, τ∗. 

Com a resultat del lliscament dels dos extrems de la barra (carregat i descarregat), la rigidesa 

d’adherència disminueix. 

És possible que apareguin diferents fallades de la unió entre els dos elements, depenent de la rati 

entre la resistència del formigó i la resistència a cisallament de les corrugues/deformacions 

superficials. 

Un cop s’ha assolit la màxima tensió d’adherència es comença a perdre la capacitat de càrrega i la 

tensió d’adherència residual depèn bàsicament dels efectes de la fricció.   
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2.3 Efecte tenso-rigidesa 

El fenomen de l’adherència entre formigó i barra de reforç té una evident conseqüència en la 

fissuració de qualsevol element de formigó armat. Per fer l’explicació més clara, ens centrarem en 

l’estudi de la fissuració d’un element de formigó armat sotmès a tracció pura.  

Si ens fixem en una secció esquerdada, tot l’esforç de tracció recau en les barres de reforç. Ara bé, 

a les zones adjacents a aquestes fissures, les tensions tangencials d’adherència fan que es generi 

una transmissió d’esforços des de l’armadura cap al formigó que l’envolta. Es genera, per tant, una 

contribució del formigó que es podria interpretar com un increment de la rigidesa de l’armadura 

tradicional. Aquesta contribució es coneix amb el nom de tenso-rigidesa (tension stiffening, en 

anglès).  

A la Figura 2.4 es mostra el procés de fissuració d’un element de formigó armat sotmès a tracció 

pura (normalment anomenat tirant) [5]. En aquest procés es poden distingir quatre etapes: i) etapa 1 

que representa l’element sense esquerdar, ii) etapa 2 en la que es formen les fissures, iii) etapa 3 on 

es produeix l’estabilització de les mateixes i iv) etapa 4 de post-plastificació pel cas de reforç d’acer. 

Cadascuna de les etapes es representa amb les lletres a, b, c i d, respectivament, i els punts R, S i Y 

corresponen a l’aparició de la primera esquerda, última esquerda i inici de la plastificació en el cas 

de reforç d’acer, respectivament.  

Podem definir l’Estat I del tirant quan els dos elements treballen conjuntament, i l’Estat II quan 

només treballa l’armadura degut a una fissuració estabilitzada, aquests dos estats corresponen a les 

etapes i) i iii), respectivament (indicades a la Figura 2.4 com a i c). 
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Figura 2.4 Comportament ideal d’un tirant de formigó armat. 

2.3.1 Procés de fissuració 

A l’inici de l’aplicació de càrrega, quan encara no hi ha cap fissura, els dos materials (formigó i 

reforç) treballen conjuntament, de manera que les deformacions unitàries del reforç, εr, i del formigó, 

εf, són iguals, i es diu que el tirant es comporta seguint la rigidesa del conjunt (Estat I). 

La primera fissura apareixerà quan la tensió de tracció al formigó superi la seva resistència a tracció. 

En aquest moment tindrem una secció fissurada on només l’acer suporta la tracció i per tant el 

formigó té deformació igual a 0. Es podria dir que aquesta secció es comporta seguint la rigidesa 

únicament de la barra de reforç (Estat II). La longitud necessària per tornar a l’Estat I, on les dues 

deformacions són les mateixes, s’anomena longitud de transferència, lt (veure Figura 2.5) 
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Figura 2.5 Perfil de distribució de deformacions al llarg del tirant en l’aparició d’una fissura 

Com es pot observar a la Figura 2.5, la deformació de la barra a la zona on hi ha fissura és màxima, 

mentre que la deformació del formigó és nul·la. A mesura que ens allunyem d’aquesta fissura, les 

deformacions tendeixen a igualar-se fins a ser del mateix valor. Que les dues deformacions siguin 

iguals indica que els dos materials treballen de manera composta. Com a resultat de l’existència 

d’aquesta primera fissura, la rigidesa del conjunt comença a disminuir. Aquest cas representa 

l’existència d’una única fissura. A mida que es vagi augmentant el nivell de càrrega, apareixeran 

noves fissures, i per tant, el patró anteriorment citat s’anirà reproduint al llarg del tirant (veure Figura 

2.6). Que vagin apareixent noves fissures vol dir que existeixen cada vegada més seccions on la 

rigidesa axial es correspondrà amb la rigidesa de la barra de reforç. Això farà que la rigidesa global 

de l’element de formigó armat vagi disminuint mica en mica (etapa b de la Figura 2.4). 
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Figura 2.6 Perfil de distribució de deformacions al llarg del tirant en la fase de formació de varies fissures. 

Un cop aparegui la última fissura, el tirant estarà a l’etapa de fissuració estabilitzada (etapa c de la 

Figura 2.4). La Figura 2.7 mostra el perfil de deformacions per aquesta etapa de fissuració 

estabilitzada.  
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Figura 2.7 Perfil de distribució de deformacions al llarg del tirant en la fase de fissuració estable. 

Un cop s’ha arribat a la fissuració estabilitzada, un augment de la força de tracció només farà que les 

fissures creixin, però no provocarà l’aparició de fissures noves, ja que al no haver-hi longitud de 

transferència suficient, el formigó no estarà sotmès a la tensió necessària per generar esquerdes. 

Totes les fissures es troben a una distància inferior a 2·lt i ja no hi ha cap zona que es trobi en estat 

I. En aquest moment la fissuració de l’element de formigó armat ha finalitzat.  

Cal tenir en compte que la resistència del formigó és una variable aleatòria que no es pot definir amb 

un únic valor, formant una població estadística. És per això que no totes les fissures apareixen a la 

mateixa tensió. És per això, i gràcies també al tension stiffening, que el tram de formació de fissures 

mai és horitzontal.  
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3 MODELS ANALÍTICS  

Existeixen dos enfocaments principals per la predicció analítica del comportament post-fissuració 

d’un tirant de formigó armat amb reforç d’acer: i) l’enfocament proposat per EC-2 [2] i MC90 [5], que 

proposen un mètode per calcular la deformació mitjana en la barra de reforç per un valor de càrrega 

després de la fissuració del formigó (en altres paraules, aquests models defineixen una resposta 

tensió-deformació modificada pel material de la barra de reforç); ii) l’enfocament proposat per ACI [6] 

que defineix una àrea efectiva de la secció transversal del tirant, en un raonament anàleg a la 

definició d’una inèrcia equivalent per l’estudi d’elements que treballen a flexió. A continuació es 

descriuen les tres formulacions. 

Proposta EC-2 

El mètode proposat consisteix en calcular la deformació mitjana en el reforç d’acer interpolant entre 

els valors de la deformació d’una secció no fissurada (ε1) i una secció fissurada (ε2): 

�� = �� �� !�! "� + �� $1 − &�&� �� !�! "�'  
Equació 5 

on β1 fa referència a l’adherència del reforç d’acer (1 per barres amb corrugues i 0.5 per barres 

llises), β2 considera el tipus de càrrega (1 per la primera càrrega i 0.5 per càrregues repetitives o 

mantingudes), σcr és la tensió en el reforç d’acer quan apareix la primera fissura (σcr = Pcrack/Ar), σr és 

la tensió de la barra d’acer a la secció esquerdada amb la càrrega actual, i ε1 i ε2 són les 

deformacions corresponents a secció no fissurada i secció fissurada, respectivament (veure Figura 

3.1). Tot i que l’Equació 5 va ser proposada per l’estudi d’elements de formigó amb reforç d’acer, es 

pot utilitzar amb reforços de FRP si es considera un valor adequat pel coeficient β1. 
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Figura 3.1 Relacions de tensió-deformació modificades pel material de reforç segons EC-2 [2] 

Proposta MC90 

Similar a la proposta de l’EC2 [2], MC90 [5] inclou la rigidesa addicional dels tirants, fruit de la 

interacció entre el formigó i el reforç, a través de la definició d’una corba tensió-deformació 

modificada pel material de reforç (veure Figura 3.2). Durant la primera fase elàstica lineal el model 

suposa que la rigidesa del conjunt és una combinació de la rigidesa dels dos materials. Superada la 

tensió on apareixen les primeres fissures i durant tota la fase d’aparició de fissures, la deformació a 

la barra de reforç es pot calcular de la següent manera: 

�� = �� − &((�� − ��!�) + (��!) − ��)
(��!) − ��!�) (��!� − ��!�) 

Equació 6 

    

on εsr1 i εsr2 són les deformacions a la barra d’acer d’una secció no fissurada i una secció fissurada, 

respectivament, σsr1 i σsr2 són les tensions a la barra d’acer a una secció fissurada quan es formen la 

primera i la última fissura, respectivament, i βt  és el factor que caracteritza la deformació del material 

reforç al llarg de la longitud de transferència, de valor 0.4 per tracció pura. Un cop assolida la 

fissuració estable, la tensió del reforç es calcula seguint la formula: 

�� = �� − &((��!� − ��!�) 

Equació 7 

Per defecte, es proposa que la tensió al reforç d’acer a la última fissura prengui el valor σsrn=1.3 σsr1. 
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Figura 3.2 Relacions de tensió-deformació modificades pel material de reforç segons MC90 [5] 

 

Proposta ACI  

En un procés anàleg al del càlcul de fletxes d’elements a flexió, ACI 224.2R-97 [6] proposa estudiar 

el comportament a tracció d’elements de formigó amb reforç d’acer de manera similar a l’enfoc del 

moment d’inèrcia efectiu [1]. Basant-se en la Equació de Branson [7], ACI proposa una expressió per 

l’àrea efectiva (Ae) que varia gradualment des de la secció bruta (Ag) fins la secció fissurada (Acr). 

*+ = *, �-.
/.0
- "� + * ! $1 − �-.
/.0

- "�' ≤ *, 

 Equació 8 

Per tal d’adaptar l’Equació 8 i fer-la aplicable a l’estudi d’elements armats amb barres de FRP, ACI 

440.1R-03 proposa la inclusió d’un nou paràmetre, βd, definit com: 

&1 = 0.5 456785� +! + 19 
Equació 9 

on EFRP és el mòdul d’elasticitat de la barra de FRP considerada i Eacer és el mòdul d’elasticitat de 

l’acer. 

D’aquesta manera, l’expressió final per l’àrea efectiva és: 

*+ = *,&1 �-.
/.0
- "� + * ! $1 − �-.
/.0

- "�' ≤ *, 

Equació 10 
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Seguint l’enfocament d’ACI, la deformabilitat de l’element s’avalua mitjançant un anàlisi elàstic, on la 

deformació mitja es calcula segons 

�� = -
5�*+ 

Equació 11 

on P és la càrrega aplicada a l’element traccionat, Ef és el mòdul de Young del formigó i Ae és l’àrea 

efectiva calculada segons l’ Equació 8 (veure Figura 3.3). 

 

Figura 3.3 Relació càrrega-deformació d’un tirant armat segons ACI 
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4 MODEL NUMÈRIC 

4.1 Introducció al Mètode dels Elements Finits 

El Mètode dels Elements Finits (MEF), és un mètode numèric que s’utilitza per resoldre de forma 

aproximada equacions diferencials parcials, sobretot en el camp de l’enginyeria i la física. 

Aquest mètode es basa en la idea de dividir un sòlid continu en un conjunt d’elements discrets. Es 

divideix el sòlid en punts, línies o plans imaginaris segons si aquest és lineal, bidimensional o 

tridimensional, respectivament. Tots els elements queden delimitats per un seguit de punts o nodes 

que els uneixen entre si. És sobre aquests punts (nodes) on queden definides totes les incògnites 

del nostre problema (en un problema estructural aquesta incògnita sol ser el desplaçament del 

node). A partir d’aquí, i mitjançant càlculs, es poden obtenir altres variables d’interès. 

Un cop obtingut el valor de desplaçaments a nodes, i fent ús de les equacions diferencials que 

defineixen el comportament del sòlid continu, és possible obtenir fórmules (funcions d’interpolació) 

que relacionen el comportament de qualsevol punt sabent el valor de les incògnites en els nodes. 

En aquest treball el programa utilitzat fer l’estudi numèric és ABAQUS, disponible al grup de recerca 

AMADE de la Universitat de Girona. Aquest és un programa que s’usa en molts camps de la 

industria, com per exemple el sector automobilístic, el sector aeroespacial i la recerca de nous 

materials, entre d’altres. 

4.2 Definició del model a simular 

El model a simular vol estudiar el comportament a tracció d’un element de formigó armat. Per 

simular aquest model es farà ús d’una triple simetria, reduint així el cost computacional. És per això 

que els models generats consisteixen en un prisme rectangular, que representaria el material 

formigó, i una quarta part de prisme cilíndric, que representa el material de reforç (veure Figura 4.1). 

  

a) b)  

Figura 4.1 a) Tirant enter b) tirant amb triple simetria 

En aquest apartat no es defineixen les propietats geomètriques dels models a realitzar. Això és 

degut a que aquest treball analitza l’efecte de la variació de la secció de formigó (i per tant, del 
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cantell b) i del diàmetre de la barra (db). La única variable geomètrica que sí es manté constant és la 

longitud total del tirant de formigó, amb una longitud de 5m.  

La càrrega a aplicar consisteix en un desplaçament a l’extrem lliure de la barra. Aquest provocarà un 

lliscament entre barra i formigó (un cop s’hagi superat la tensió d’adherència) i conseqüentment la 

fissuració del tirant. 

Es faran diferents models canviant les característiques geomètriques del formigó i de la barra de 

reforç, per tal d’observar l’existència o no de canvis significatius en el comportament final del tirant i 

veure quins paràmetres són més influents en la fissuració i el fenòmen del tension stiffening dels 

tirants. Addicionalment, es farà un estudi sobre l’efecte de les propietats mecàniques de la barra de 

reforç en el fenòmen del tension stiffening.  

4.3 Modelització amb elements continus hexaèdrics, elements connectors i 

contactes superfície-superfície 

En aquest apartat es presenten els diferents tipus d’elements que s’han fet servir, i es presenten els 

materials considerats i les seves propietats mecàniques.  

4.3.1 Estudi teòric dels elements utilitzats. 

Per tal de modelar el volum de formigó i de barra de reforç es fan servir elements rectangulars tipus 

hexaèdric, ja que es modela un volum. D’entre els elements disponibles a ABAQUS, s’escull 

l’element C3D8R, consistent en un element hexaèdric amb vuit nodes i integració reduïda, és a dir, 

només té un punt d’integració en el punt central del volum de l’element (veure Figura 4.2). Es creu 

que aquesta tipologia d’element és la més adequada per calcular deformacions i tensions en l’espai 

tridimensional. 

 

 
Figura 4.2 Element C3D8R 

Els vèrtexs del volum corresponen als nodes i la “X” marcada al centre del cub és l’únic punt 

d’integració. 

La modelització de l’adherència es realitzarà mitjançant la modelització del mecanisme de interacció 

mecànica i el mecanisme de fricció. Pel primer dels mecanismes, es fa servir elements connectors 
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CONN3D2, elements de dos nodes per l’anàlisi tridimensional amb sis graus de llibertat. Pel segon 

dels mecanismes es defineixen contactes “surface-to-surface”. 

4.3.2 Definició dels materials 

En aquest apartat es defineixen els materials utilitzats i es presenten les seves propietats 

mecàniques. 

4.3.2.1. Formigó 

El formigó és un material fràgil, que suporta molt bé els esforços de compressió però té una 

capacitat limitada per resistir esforços de tracció. Succeeix també, que per ambdós casos (tracció i 

compressió) el material té un comportament inicial elàstic lineal fins arribar als seus límits de tracció i 

compressió. A partir d’aquests límits, el comportament del formigó passa a ser no lineal.  

En aquest estudi numèric es consideren les lleis constitutives proposades per CEB-FIB Model Code 

2010 [3], per modelar la relació tensió-deformació a compressió (veure Figura 4.3a) i el 

comportament post-fissuració a tracció (veure Figura 4.3b) 

 

Figura 4.3 Lleis constitutives assumides per: a) comportament tensió-deformació uniaxial a compressió [3]; b) 
comportament post-fisuració a tracció [3]. 

Els valors de resistència característica a compressió (fcm), resistència mitjana a tracció axial (fctm) i 

mòdul secant d’elasticitat (Ecm) que es fan servir són els proposats també a EC-2 [2] i CEB-FIB 

Model Code 2010 [3]. 

: � = : ; + 8 

Equació 12 
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: (� = 0.3(: ;)� �  >  

Equació 13 

5 � = 22 @ 10� �: �10 "A.�
 

Equació 14 

En aquest estudi es considera un formigó amb resistència fck=25MPa, i per tant s’obtenen valors  de 

fcm=33 MPa, fctm=2.56 MPa, Ecm=31475.8 MPa i εcr= fctm /Ecm=81.33 µε. 

4.3.2.2. Reforç 

Per modelar el material de reforç es considera un comportament isotròpic elàstic lineal, tal i com es 

mostra a la Figura 4.4. Com a valor base es considera un mòdul de Young, Er= 40000 MPa. Ara bé, 

en un dels estudis que es planteja en aquest treball, s’analitza l’efecte del rati del mòdul elàstic del 

material reforç respecte el mòdul elàstic del formigó (n=Er/Ef). En aquest cas, aquest valor anirà 

canviant. 

 

Figura 4.4 Llei tensió-deformació uniaxial de tracció pel material de reforç. 

4.3.3 Definició de l’adherència 

En aquest estudi es contempla la llei d’adherència proposada a MC2010 [3] (veure Figura 2.2) que 

es caracteritza per 4 trams clarament diferenciats (Equacions 1 - 4). Seguint les indicacions de 

MC2010 [3], la màxima tensió d’adherència es calcula a partir de les propietats del formigó (veure 

Equació 15) i els valors dels altres paràmetres són: α=0.4, s1=1mm, s2=2mm, s3=4mm i τf= 0.4 τmax. 

���� = 2.5B: ; 

Equació 15 
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Tal i com s’ha comentat anteriorment, els dos mecanismes d’adherència que es tenen en compte en 

aquest estudi són la interacció mecànica i la fricció. Com a conseqüència la corba de pull-out 

proposada a MC2010 [3] es dividirà en dues corbes que s’implementaran de forma diferenciada 

(veure Figura 4.5). La interacció mecànica es modelitza mitjançant elements connectors CONN3D2. 

Aquests elements de dos nodes es col·loquen a la interfície barra-formigó, amb un dels nodes en 

contacte amb un node de formigó i l’altre en contacte amb un node de la barra (els dos nodes estan 

situats a la mateixa posició física) (veure Figura 4.6). El seu comportament constitutiu es defineix 

amb una taula de valors, de manera que la interacció mecànica total es modelitza a partir de 

l’addició de la interacció mecànica definida a cada element CONN3D2 (és a dir, cada parell de 

nodes d’un element CONN3D2 contribueix a la interacció mecànica total). Per modelitzar la fricció 

s’utilitzen superfícies de contacte “surface-to-surface” en les que cal definir un coeficient de fricció 

que serà únic a tota la longitud adherida (veure Figura 4.6) 

 

Figura 4.5 Mecanismes adherència, fricció i interacció mecànica. 
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Figura 4.6 Nodes i superfície contacte 

5 VARIABLES D’ESTUDI 

És l’objectiu d’aquest treball estudiar la possible influència de paràmetres com quantia geomètrica 

(ρ), diàmetre de la barra (db), cantell de la secció rectangular de formigó (b) o rati del mòdul elàstic 

del material de reforç respecte mòdul elàstic del formigó (n=Er/Ef) sobre la fissuració i el fenomen del 

tension stiffening de tirants de formigó armat. És per això que a continuació es descriuen els 

diferents casos d’estudi contemplats. 

5.1 Casos d’estudi 

Aquest treball es centra en l’estudi de l’efecte de la quantia geomètrica (ρ) i l’estudi de l’efecte del 

rati de mòduls d’elasticitat dels dos materials (n). Cal tenir en compte però, que la quantia 

geomètrica es defineix com el rati entre àrea de reforç i àrea de formigó, i per tant aquí hi ha dues 

variables a analitzar de manera independent, com són el diàmetre de la barra (db) i el cantell de 

formigó (b). Basant-se en això, es proposen els següents casos d’estudi. 

5.1.1 Efecte de la quantia geomètrica ρ  (ρ=Ar/Af) 

5.1.1.1 Variació de ρ degut a la variació de l’àrea de formigó (Af) 

Per aquest estudi es considera un diàmetre de barra constant, igual a 19mm, i es modifica el cantell 

de formigó, b, per tal d’obtenir uns valors de ρ compresos entre 0.01 i 0.04. La Taula 5.1 mostra els 

quatre casos analitzats, definint el nom del tirant i els valors de les variables geomètriques. 

Tirant dr (mm) b (mm) Af (mm2) ρ 

CS1 19 170 28900,00 0,98% 

CS2 137,48 18900,75 1,50% 

CS3 97,216 9450,95 3,00% 

CS4 84,19 7087,96 4,00% 

Taula 5.1 Propietats geomètriques dels diferents casos d’estudi per l’anàlisi de l’efecte de la variació de l'àrea del formigó 
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5.1.1.2 Variació de ρ degut a la variació del diàmetre de barra (db) 

Per aquest estudi es considera un cantell de formigó constant, igual a 170mm, i es modifica el 

diàmetre de la barra de reforç, db, per tal d’obtenir els mateixos valors de ρ del cas anterior. La Taula 

5.2 mostra els quatre casos analitzats, definint el nom del tirant i els valors de les variables 

geomètriques. 

Tirant b (mm) dr (mm) Ar (mm2) ρ 

RD1 170 18,20 260,10 0,90% 

RD2 23,49 433,50 1,50% 

RD3 33,22 867,00 3,00% 

RD4 38,36 1156,00 4,00% 

Taula 5.2 Propietats geomètriques dels diferents casos d’estudi per l’anàlisi de l’efecte de la variació del diàmetre de la 
barra 

5.1.1.3 Variació de l’àrea de formigó (Af) i el diàmetre de la barra (db), amb ρ constant 

Per aquest estudi es considera una quantia geomètrica constant, igual a 1.5%, i es modifiquen tant 

el cantell de formigó (b) com el diàmetre de la barra de reforç (db). La Taula 5.3 mostra els tres casos 

analitzats, definint el nom del tirant i els valors de les variables geomètriques. 

Tirant ρ dr (mm) Ar (mm2) b (mm) Af (mm2) 

CR1 1,50% 12 113,10 86,83 7539,82 

CR2 16 201,06 115,78 13404,13 

CR3 19 283,53 137,48 18901,92 

Taula 5.3 Propietats geomètriques dels diferents casos d’estudi per l’anàlisi de l’efecte de la variació d’àrea de formigó i 
diàmetre de barra, donant ρ constant 

5.1.2 Estudi de l’efecte del rati de mòduls elàstics n (n=Er/Ef) 

Per aquest estudi es mantenen constants totes les variables geomètriques del model (db i b) per tal 

de tenir un valor ρ=1,5% constant, i es modifica el mòdul de Young de la barra de reforç (Er). Aquest 

estudi pretén analitzar l’efecte de les diferents tipologies de barres de FRP que existeixen (carboni, 

vidre, aramida,...); és per això que s’escullen valors de mòdul de Young de la barra de reforç que 

donin ratis de mòduls entre 1 i 6. La Taula 5.4 mostra els sis casos analitzats, definint el nom del 

tirant i els valors de les variables mecàniques. 

Tirant dr (mm) b (mm) ρ Er (MPa) Ec (MPa) n (Er/Ec) 

MR1 

19 137,48 1,50% 

31475,8 

31475,80 

1 

MR2 62951,6 2 

MR3 94427,4 3 

MR4 125903,2 4 

MR5 157379 5 

MR6 188854,8 6 

Taula 5.4 Propietats mecàniques dels diferents casos d’estudi per l’anàlisi de l’efecte de la variació del rati de mòduls de 
Young 



Estudi numèric de la fissuració d’elements de formigó armat. Memòria. 

27 

 

6 RESULTATS I CONCLUSIONS 

Tradicionalment, els diferents treballs experimentals i/o analítics que analitzen el fenomen de 

l’adherència i el tension stiffening presenten els seus resultats assignant la rigidesa addicional 

derivada del tension stiffening, ja sigui a la llei constitutiva de la barra o a la llei constitutiva del 

formigó a tracció (veure Figura 6.1). 

  
a) b) 

 
Figura 6.1 Possibles enfocaments per l’estudi del tension stiffening ( a) enfocament d’assignació del tension stiffening a la 

deformació de la barra i b) enfocament de repartiment de càrrega) 

Els resultats d’aquest treball es presentaran seguint la segona representació, coneguda amb el nom 

d’enfocament de repartiment de càrrega, i en la que es considera un comportament perfectament 

fràgil de la barra de reforç. 

6.1 Efecte de la quantia geomètrica, ρ 

En aquest apartat s’analitza l’efecte de la quantia geomètrica, ρ. Tal i com s’ha comentat abans, 

aquest estudi es divideix en tres subestudis: i) anàlisi de l’efecte de la variació de quantia geomètrica 

com a resultat de la variació de l’àrea de formigó; ii) anàlisi de l’efecte de la variació de la quantia 

geomètrica com a resultat de la variació del diàmetre de la barra; iii) anàlisi de la variació d’àrea de 

formigó i diàmetre de barra, donant una quantia geomètrica constant. 

Les propietats mecàniques dels materials s’han mantingut constants pels tres subestudis. Els valors 

utilitzats han estat fck=25MPa, fcm=33 MPa, fctm=2.56 MPa, Ecm=31475.8 MPa, εcr= fctm /Ecm=81.33 µε 

(pel que fa referència al formigó), Er=40000MPa (pel que fa referència a la barra) i τmax=14,36 MPa, 

α=0.4, s1=1mm, s2=2mm, s3=4mm i τf= 0.4 τmax. (pel que fa referència a l’adherència). 
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6.1.1 Variació de ρ degut a la variació de l’àrea de formigó (Af) 

Per aquest subestudi s’ha mantingut un diàmetre de barra de reforç constant de 19mm, i s’han 

seleccionat diferents valors d’àrea de formigó per tal d’obtenir valors de quantia geomètrica de 0.9, 

1.5, 3 i 4%, respectivament (veure Taula 5.1).  

Primerament, es fa una comparativa entre els resultats numèrics obtinguts i les prediccions de MC90 

i EC-2. Pel cas de EC-2 es consideren dues prediccions, essent el factor d’adherència, β1 la 

diferència entre elles (β1=1 per barres amb corrugues i β1=0,5 per barres llises). 

 La Figura 6.2 mostra aquestes comparatives pels quatre casos estudiats. D’acord amb els resultats 

obtinguts, els resultats de les simulacions numèriques són coherents amb les prediccions 

analítiques. 
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Figura 6.2 Comparativa entre resultats numèrics i prediccions analítiques pels casos: a) CS1; b) CS2; c) CS3; d) CS4 

La Figura 6.3 mostra la comparativa dels resultats numèrics dels quatre casos d’estudi d’aquest 

apartat (CS1, CS2, CS3 i CS4). Els resultats numèrics mostren que el canvi en la quantia 

geomètrica, derivat d’un canvi en l’àrea de formigó, té un efecte significatiu en el fenomen del 

tension stiffening, obtenint més tension stiffening en aquells casos en que la quantia geomètrica és 

més petita. 
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Figura 6.3 Comparativa CS1, CS2, CS3, CS4 

 
6.1.2 Variació de ρ degut a la variació del diàmetre de barra (db). 

Per aquest subestudi s’ha mantingut un cantell de formigó constant de 19mm, i s’han seleccionat 

diferents valors de radi de la barra de reforç per tal d’obtenir valors de quantia geomètrica de 0.9, 

1.5, 3 i 4%, respectivament (veure Taula 5.2). 

Seguint el mateix procediment, es fa una comparativa entre els resultats numèrics obtinguts i les 

prediccions de MC90 i EC-2. Pel cas de EC-2 es consideren dues prediccions, essent el factor 

d’adherència, β1 la diferència entre elles (β1=1 per barres amb corrugues i β1=0,5 per barres llises). 

La Figura 6.5 mostra aquestes comparatives pels quatre casos estudiats. D’acord amb els resultats 

obtinguts, els resultats de les simulacions numèriques són coherents amb les prediccions 

analítiques. 
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d) 

Figura 6.4  Comparativa entre resultats numèrics i prediccions analítiques pels casos: a) RD1; b) RD2; c) RD3; d) RD4 

La Figura 6.5 mostra la comparativa dels resultats numèrics entre RD1, RD2, RD3 i RD4. Aquests 

resultats confirmen la tendència anteriorment vista que indica que el canvi de la quantia geomètrica, 

produïda ara per la variació del diàmetre de la barra de reforç, provoca canvis significatius en l’efecte 

del tension stiffening. 

 

Figura 6.5 Comparativa RD1, RD2, RD3, RD4 
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6.1.3 Variació de l’àrea de formigó (Af) i del diàmetre de barra (db), amb ρ constant. 

Per aquest subestudi s’ha mantingut la quantia geomètrica constant a 1.50%, seleccionant diferents 

valors d’àrea de formigó i de diàmetre de la barra per tal de mantenir-la constant. (veure Taula 5.3). 

També en aquest subestudi, es fa una comparativa entre els resultats numèrics obtinguts i les 

prediccions de MC90 i EC-2. Pel cas de EC-2 es consideren dues prediccions, essent el factor 

d’adherència, β1 la diferència entre elles (β1=1 per barres amb corrugues i β1=0,5 per barres llises). 

La Figura 6.7 mostra aquestes comparatives pels tres casos estudiats. D’acord amb els resultats 

obtinguts, els resultats de les simulacions numèriques són coherents amb les prediccions 

analítiques. 
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c) 

Figura 6.6 Comparativa entre resultats numèrics i prediccions analítiques pels casos: a) CR1; b) CR2; c) CR3 

La Figura 6.7 mostra la comparativa dels resultats numèrics dels tres casos d’estudi. D’acord amb la 

figura no s’observen canvis significatius en els resultats numèrics obtinguts quan la quantia 

geomètrica es manté constant, independentment de la combinació d’àrea transversal de reforç i àrea 

transversal de formigó que s’esculli. 

 

Figura 6.7 Comparativa CR1, CR2, CR3 
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6.2 Efecte del rati de mòduls elàstics (n) 

Per aquest estudi s’han mantingut totes les propietats geomètriques (cantell, diàmetre barra de 

reforç, quantia geomètrica) i s’ha modificat el mòdul elàstic de la barra de reforç per obtenir uns ratis 

n=1,2,3,4,5 i 6. (veure Taula 5.4). 

Primerament, es fa una comparativa entre els resultats numèrics obtinguts i les prediccions de MC90 

i EC-2. Pel cas de EC-2 es consideren dues prediccions, essent el factor d’adherència, β1 la 

diferència entre elles (β1=1 per barres amb corrugues i β1=0,5 per barres llises). La Figura 6.8 mostra 

aquestes comparatives pels sis casos estudiats. D’acord amb els resultats obtinguts, els resultats de 

les simulacions numèriques són coherents amb les prediccions analítiques. 
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c) 
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f) 

Figura 6.8 Comparativa entre resultats numèrics i prediccions analítiques pels casos: a) MR1; b) MR2; c) MR3; d) MR4;     

e) MR5; f) MR6 

La Figura 6.9 mostra la comparativa entre els sis resultats numèrics dels casos d’estudi. Es pot 

observar que l’efecte de tension stiffening queda afectat pel rati de mòduls elàstics, obtenint valors 

majors de l’efecte tension stiffening per valors inferiors de n. 

 

Figura 6.9 Comparativa MR1, MR2, MR3, MR4, MR5, MR6 
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6.3 Conclusions generals 

En aquest treball s’ha realitzat un estudi sobre el fenomen del tension stiffening i com aquest es 

troba afectat per la quantia geomètrica (ρ) i la relació de mòduls elàstics (n). 

D’acord amb els resultats numèrics obtinguts, qualsevol canvi en les propietats geomètriques que 

signifiquin un canvi en la quantia geomètrica, ρ, produirà variacions del tension stiffening, obtenint 

unes quantitats majors de tension stiffening per valors de quantia geomètrica més petits. 

Ara bé, el fenomen de tension stiffening és independent de com es combinin les propietats 

geomètriques per obtenir una quantia geomètrica fixa. 

Els resultats numèrics obtinguts també confirmen que la relació de mòduls, n, té un efecte sobre el 

tension stiffening, obtenint valors més elevats de tension stiffening per valors inferiors del rati de 

mòduls. 
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7 RESUM DEL PRESSUPOST 

La següent valoració  econòmica fa referència al cost de la realització d’aquest estudi separat per les 

diferents partides. 

Partida Descripció Cost unitari Quantitat Rend./Amor. Cost total 

1 Amortització Hardware 1,800 € 1 0.17 300.00 € 

2 Amortització Software 1,200 € 1 0.17 200.00 € 

3 Modelització i anàlisi 35€/hora 200 75% 5,250.00 € 

4 Redacció de l'estudi 20€/hora 75 75% 1,125.00 € 

Subtotal 6,875.00 € 

15% C. Indirectes 1,031.25 € 

7,906.25 € 

9% Benefici 711.56 € 

8,617.81 € 

16% IVA 1,378.85 € 

TOTAL 9,996.66 € 
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ANNEX A. TUTORIAL ABAQUS 

En aquest annex s’explicarà el procediment seguit per realitzar els models numèrics i l’anàlisi dels 

mateixos. 

El procediment és: 

- Primera fase 

1. Obrir el programa Abaqus Cae 

2. A la finestra Start Session, clicar a la icona With Standard/Explicit Model 

La Module List mostra diferents passos a seguir per crear qualsevol model. Aquesta llista serà la 

referència a l’hora de realitzar els models. 

Module List: Part 

A continuació es generen les diferents geometries involucrades en el model, concretament la barra 

de reforç i el formigó. Només serà necessari modelar 1/8 de tot el tirant. 

1. Clicar Part > Create 

2. A la finestra Create Part definir l’element a dibuixar (barra o formigó) i deixar la resta 

d’opcions tal i com estan. Clicar Continue. 

3. Amb l’ajuda dels diferents elements de dibuix (línies, arcs i rectangles) dibuixar la geometria 

del tirant (definir i dibuixar els dos volums per separat). 

 

Figura A. 1 Geometria barra 

4. Un cop definida la geometria clicar el botó central del ratolí per definir la profunditat de 

l’element (2500mm pel formigó i 2600mm per la barra). 
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Figura A. 2 Profunditat barra 

5. Repetir el mateix procediment pel formigó (Pas 1, 2, 3 i 4) 

 

Figura A. 3 Barra acabada 

6. A continuació es definiran els Sets que posteriorment es faran servir per facilitar la definició 

de nodes característics, com són els nodes de simetria, els de càrrega o els de contacte 

entre la superfície FRP-formigó. Seleccionar Tools > Set > Manager > Create. El primer set 

s’anomenarà Bar i serà la barra. El segon s’anomenarà Concrete i farà referència al formigó. 

En aquest pas sempre es relaciona la geometria amb el Set. 

 

Figura A. 4 Definició del set del formigó 
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Fins aquí arriba la definició geomètrica dels elements que formaran el tirant. 

Module List: Assembly 

En aquest mòdul es fa l’assemblatge de les dues parts que conformen el tirant. 

7. Clicar Instance Part, seleccionar la barra i el formigó i seleccionar la opció Independent. 

S’obté una figura similar a la següent: 

 

Figura A. 5 Assemblatge del formigó i la barra 

Module List: Mesh 

8. Seleccionar Tools > Partition. A la pestanya que apareix seleccionar  Type:Cell i Extend 

Face, clicar sobre la barra i botó central del ratolí, després clicar sobre la cara del formigó 

que hi sobresurt la barra. Un cop fet, clicar  Create Partition. 

 

Figura A. 6 Partició tirant 

9. Anar a Mesh > Controls, seleccionar tota la barra, i al quadre de diàleg que apareix continuar 

sense tocar cap paràmetre. 
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10. Anar a Mesh > Element Type, seleccionar tota la barra, i al quadre de diàleg marcar que 

l’element ha de ser Explicit, deixar tots els altres paràmetres iguals. 

11. Activar vista sense cares, només arestes. Anar a Seed > Edges i seleccionar les tres arestes 

de la barra dels dos extrems i de la partició que s’ha creat. A continuació clicar botó central 

del ratolí i, al quadre de diàleg que apareixerà, indicar el mètode By number i 8 elements. 

Seleccionar la resta de tirant i seleccionar opció By size amb un valor de 4.  

12. Clicar Mesh Part Instance i seleccionar tot el tirant per crear el mallat, clicar Ok. 

13. Anar a Mesh > Create mesh part, seleccionar tot el tirant i clicar Ok. Cal donar-li un nom. 

14. Anar a l’arbre del lateral esquerra, seleccionar el model actual, copiar-lo i canviar el nom del 

model còpia. A partir d’ara treballarem amb aquest model còpia.  Obrir la pestanya Parts de 

l’arbre i esborrar el formigó i la barra. Anar a l’Assembly i acceptar l’error que ens surt, i crear 

un nou assemblatge amb l’únic element que hi ha. Tornar al mòdul Mesh. 

15. És important tenir seleccionat a Object � Part: (nom que s’ha donat abans al crear la part del 

mesh).  Seguidament anar Tools > Set > Manager, cal definir les diferents simetries i els 

nodes on s’aplicarà la càrrega. Per fer-ho, cal crear un nou set de nodes per a cada una de 

les simetries i les càrregues, així com els nodes de contacte.  

Un cop obert el manager dels sets, clicar create i donar nom al set, indicant que es tracta de 

nodes, clicar Continue i seleccionar els nodes que formen part d’aquell set. 

Els sets seran: 

� Càrrega: Extrem de la barra que queda lliure de formigó. 

� Simetria X 

� Simetria Y 

� Simetria Z i reacció: S’aprofita aquesta simetria per calcular les forces que 

apareixen de reacció. 

� Nodes contacte formigó: Part interior del formigó que està en contacte amb la 

barra. 

� Nodes contacte barra: Part de la barra que està en contacte amb el formigó.  

  

a) Nodes càrrega b) Nodes simetria Z i reacció 

Figura A. 7 Sets de nodes 

Per visualitzar els nodes de contacte de la barra i formigó cal anar a Tools > Display Group > 

Create, . Per facilitar la selecció cal activar la vista yz i treure la perspectiva. A l’apartat Item 
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clicar Elements i a l’apartat Method, clicar Pick from view port. A continuació seleccionar tots 

els elements que sobresurten de la barra i clicar Done. A la pestanya que ens tornarà a 

aparèixer seleccionar Remove i seguidament clicar Sets. En aquest punt, seleccionar el set 

del formigó i clicar Remove. Obrir el manager dels sets i també de les superfícies i crear un 

set de nodes de contacte i un set de superfície de contacte, en tots dos casos de la barra. 

Tornar a obrir el Display Group i seleccionar el formigó i clicar Replace, fer els mateixos 

passos que amb la barra (nodes i superfície de contacte). 

Module List: Property 

16. Clicar Create Material, indicar el nom del material, FRP, i clicar Ok. Fer el mateix procediment 

pel concrete. 

 

Figura A. 8 Creació material 

17. Clicar Create Section, indicar la secció (barra o formigó) i clicar Continue, en el desplegable 

Material seleccionar quin dels dos materials s’assigna a cada secció. 

 

 

Figura A. 9 Assignació del material a la secció 

18. Clicar Assign Sections. A la barra inferior clicar Sets i assignar al set Barra la secció creada. 

Fer el mateix procediment pel formigó. 
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Figura A. 10 Assignació de les seccions als sets 

Module List: Step 

19. Clicar Step > Create, i clicar Continue a la pestanya que apareix; seguidament indicar que el 

període és de 0.1 i clicar Ok. 

20. Clicar Output > History Output Requests > Create. A continuació apareix el quadre Create 

History i clicar Ok. A l’apartat Domain seleccionar Set i al costat indicar de quin es tracta. Just 

a sota caldrà indicar quines variables s’han d’estudiar, les combinacions seran: 

� Domain: Set: Reacció (o simetria Z) i Forces/Reactions > RF > RF3 

� Domain: Set: deformació i Strains > E > E33 

Serà necessari crear el set de deformació, cal seguir el mateix procediment que amb els 

altres, però indicant que és un set d’elements.  

Seleccionar amb el Display Group i Elements-Pick from viewport només els elements que es 

troben a l’interior de la barra. 

 

Figura A. 11 Elements necessaris per fer el set de deformació 

Canviar la visualització a yz i seleccionar tots els elements excepte el primer, cinquè, desè, 

quinzè i així successivament fins arribar al final de la barra. (Atenció, l’últim element de la 

barra no s’hauria de seleccionar, però és necessari fer-ho.) 

A continuació clicar Remove per eliminar tots els elements que no utilitzarem i crear un Set 

d’elements anomenats deformació. 

Module List: Interaction 
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21. Treure la barra mitjançant el Display Group. Clicar Tools > Costumize > Pestanya Functions 

> Display Group > Invert Display i crear una combinació de tecles (per exemple, Ctrl + D). 

Això permet canviar del formigó a la barra amb les tecles.  

22. Canviar la visualització per només veure les arestes i clicar Create Wire Feature, a la 

pestanya clicar al símbol “+” i seleccionar tres parells de nodes, seleccionant primer el del 

formigó i després la seva parella a la barra. Clicar Ok un cop seleccionades les tres parelles. 

23. Clicar Create Connection Section i seleccionar els paràmetres següents: 

� Connection Category: Basic 

� Translational type: Cartesian 

� Rotational type: Align 

A continuació clicar continue i a la nova finestra que apareix seleccionar + > Elasticity  a 

Force/Movement . Clicar F1 i introduir el valor 2164.  

 

Figura A. 12 Creació connectors 

24. Clicar botó Create Connector Assignment i seleccionar a la barra inferior Set, a la pestanya 

Region Selection, seleccionar l’únic que apareix i clicar continue. Seguidament seguir clicant 

Ok o Continue. 

25. Clicar Special > Inertia > Manager > Create a la pestanya que ens apareix seleccionar el set 

dels nodes de contacte de la barra, i a la nova finestra entrar els valors: 
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Figura A. 13 Inèrcia nodes de contacte de la barra 

Repetir el mateix procediment pels nodes de contacte del formigó. 

26. Clicar Create Interaction i seleccionar l’opció Surface-to-surface contact (explicit). Clicar 

Continue i a la finestra que apareix seleccionar primer la superfície de contacte de la barra i 

clicar Continue, indicar Surface a la barra inferior i seguidament seleccionar la superfície del 

formigó i clicar Continue. 

Apareix una nova finestra anomenada Edit Interaction, clicar el botó que apareix al costat de 

Contacte Interaction Property i clicar Continue. A la nova finestra que apareix clicar 

Mechanical > Tangencial behaviour i en l’opció  friction formulation seleccionar Penalty i 

donar-li valor de 1.3. 
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Figura A. 14 Interacció entre les dues superfícies 

Module List: Load 

27. Clicar Creat Boundary Condition, seleccionar per les tres simetries com a Step: Initial i per la 

càrrega Step: Step-1. Deixar la resta de paràmetres igual i clicar Ok. 

A la finestra que apareix seleccionar simetria X i assignar quina simetria se li ha d’aplicar. 

Repetir el mateix procediment per les altres simetries. 

Les combinacions seran: 

� Simetria X � XSYMM 

� Simetria Y � YSYMM 

� Reacció � ZSYMM 

A continuació, per definir la càrrega és necessari seleccionar l’opció Displacement/Rotation i 

seleccionar l’Step-1.  
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Figura A. 15 Assignació càrregues i simetries 

A continuació seleccionar la direcció del desplaçament, U3 i assignar-li valor 20. Clicar botó 

situat al costat d’Amplitude i definir un Smooth Step i assignar-la al desplaçament. 

 

Figura A. 16 Definició smooth step 
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Figura A. 17 Desplaçament dels nodes de càrrega 

Module List: Job 

28. Clicar Create Job i anomenar-lo, clicar Ok. 

29. Clicar al Job Manager > Write Input. 

 

Obrir arxiu INP 

Aquests són els passos necessaris per modelitzar amb Abaqus CAE un tirant de formigó armat. 

Seguidament cal anar a la carpeta on tenim guardat l’arxiu CAE i obrir el nou arxiu que s’ha generat 

amb extensió INP.  

30. Eliminar el següent fragment: 

“ *Bulk Viscosity 

0.06, 1.2 “ 

31. Afegir els següents fragments:  

En l’apartat que defineix els materials, apartat Materials, cal canviar el contingut pel que apareix a 

continuació: 

** MATERIALS 

**  
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*Material, name=Concrete 

*Density 

 2.2e-09, 

*Elastic 

31480., 0.3 

*Concrete Damaged Plasticity 

 45, 0.1,   1.16,   0.66,     0. 

*Concrete Compression Hardening 

31.45534264, 0 

32.01684405, 0.000799765 

32.4499929, 0.000886233 

32.75687923, 0.000976646 

32.93954793, 0.001070939 

33, 0.00116905 

32.94019367, 0.001270919 

32.76204556, 0.001376484 

32.46743179, 0.001485688 

32.05818902, 0.001598473 

31.53611549, 0.001714783 

30.90297203, 0.001834563 

30.16048303, 0.001957759 

29.31033734, 0.002084319 

28.35418923, 0.00221419 

27.29365926, 0.002347321 

26.13033509, 0.002483665 

24.86577237, 0.002623171 

23.50149552, 0.002765792 
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22.03899849, 0.002911482 

20.47974555, 0.003060194 

18.82517199, 0.003211885 

17.07668487, 0.003366509 

15.32972324, 0.003521086 

13.8419812, 0.003667564 

12.57581692, 0.00380712 

11.48714137, 0.003941131 

10.54268655, 0.004070637 

9.716891931, 0.004196436 

8.989805761, 0.00431915 

8.345635431, 0.004439275 

7.771724374, 0.004557204 

7.257816035, 0.004673259 

6.795515237, 0.004787702 

6.377887907, 0.004900749 

5.999159443, 0.005012581 

5.654484545, 0.005123349 

5.339769531, 0.005233181 

5.051533713, 0.005342186 

4.786800212, 0.005450456 

4.543009157, 0.005558072 

4.317948137, 0.005665103 

4.109696015, 0.005771609 

3.91657724, 0.005877643 

3.737124427, 0.005983249 

3.570047522, 0.006088468 
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3.41420825, 0.006193337 

3.268598813, 0.006297886 

3.132324053, 0.006402143 

3.004586427, 0.006506134 

2.884673308, 0.00660988 

2.771946197, 0.006713402 

2.665831516, 0.006816717 

2.565812734, 0.006919842 

2.47142359, 0.00702279 

2.382242256, 0.007125577 

2.29788628, 0.007228212 

2.218008199, 0.007330707 

2.142291717, 0.007433073 

2.070448366, 0.007535317 

2.002214583, 0.007637449 

1.937349146, 0.007739475 

1.875630907, 0.007841404 

1.816856801, 0.00794324 

*Concrete Tension Stiffening, type=DISPLACEMENT 

2.56, 0 

0.512, 0.05089933 

0, 0.25449667 

*Material, name=FRP 

*Density 

 2.2e-09, 

*Elastic 

 40000, 0.2 
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** 

I també substituir en l’apartat Connector behaviour pel següent text: 

*Connector Behavior, name=ConnSect-1 

*Connector Elasticity, component=3 

5000., 

*Connector Plasticity, component=3 

*Connector Hardening, definition=TABULAR 

17.00, 0.10 

39.71, 0.30 

52.38, 0.50 

62.26, 0.70 

73.93, 0.99 

74.29, 1.00 

74.29, 2.00 

4.00, 4.00 

4.90, 20.00 

32. Seguidament crear arxius de text i copiar els nodes que conformen el model sencer, els 

nodes de contacte del formigó i els nodes de contacte de la barra, amb els noms Nodes, 

Nodes_contacte_formigo i Nodes_contacte_bar respectivament. I executar l’arxiu de matlab 

que ens genera les parelles de nodes. 

33. Substituir els valors dels arxius generats anomenats Nodes_contacte i Elements_contacte als 

apartats titulats *Element, type = CONN3D2 i *Nset, nset=wire-1-set-1, instance=(nom del 

model) i en la línia que *Elset, elset=wire-1-set-1, generate indicar el número inical i final de 

l’arxiu Elements_contacte, que corresponen al 100000 i 105634 respectivament. Es comença 

pel valor 10000 per evitar coincidències amb possibles nodes ja creats. 

Cal tenir en compte que l’arxiu de matlab ha estat configurat especialment per aquests 

models, en cas de que variessin el nombre de nodes de contacte s’hauria de modificar (en 

els models és de 5634).   

Un cop modificats tots els valors de l’arxiu INP, s’envia a calcular. 
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Arxiu ODB: Extracció de resultats 

34. Obrir arxiu ODB, clicar Create XY Data i seleccionar ODB history output. A continuació 

seleccionar tots els nodes que fan referència a la REACCIÓ, clicar Save as i seleccionar 

l’opció sum((XY,XY,...)), clicar OK. Fer el mateix per cada un dels elements de deformació 

però guardar cada un d’ells per separat i anomenant-lo pel seu número d’element. 

35. Clicar novament Create XY Data i seleccionar Operate on XY Data. Als Operators clicar 

Combine(X,X) i anar fent combinacions del sumatori de totes les reaccions i cada un dels 

elements de deformació. 

36. Obrir l’XY Data manager i copiar la informació a l’excel de tractament de dades. 
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